Troubleshooting Digital Certificates ‘

This document describes common issues that may arise during the application process and or import/export of digital
certificates. If this guide does not reference or resolve the issue you are experiencing, please contact cert.admin@aeso.ca for
further assistance. Topics addressed in this document are as follows:

Enrollment Delays

Enrollment code not recognized

Chrome or Edge Extension Error

Certificate not trusted — installation of Root Security Certificate
Firewall preventing you from accessing your certificate
Unable to Login to ETS

Installing certificates on a new computer

Keep in mind that due to privacy parameters, information pertaining to digital certificates can only be disclosed to an authorized
contact or certificate holder. If you do not know who your authorized contact is for your organization, you can reference the Pool

Participant list.

Enroliment Delays

Delays in receiving approval for an ETS digital certificates request could be due to one of the following common issues:

e UserAccess Request Form (step 1) was not submitted by an authorized contact.
e User Access Request Form (step 1) is submitted using an older version of the form.
e The information submitted during the online enroliment (step 2) does not match step 1.

If you have not received approval of your digital certificate request within than 3 business days, please verify the steps
above have been completed, and if necessary, send us an email at cert.admin@aeso.ca for additional assistance.

Please note that our request form is updated on occasion as requirements change. It is recommended to visit our website to
obtain the latest version, rather than saving local copies to your computer. The request form as well as our guides can be found
by visiting the AESO website at www.aeso.ca and following the path - Market > Market-Participation > System Tools > Energy
Trading System Tools.

Enroliment code not recognized

You may receive the following error messages if you have mistyped your enrollment code or if it has been more than 30 days
since your Enrollment Request was approved. Your enroliment code can be obtained by contacting cert.admin@aeso.ca.

digicert digicert’
Enroll: Enter enroliment code Install certificate Next steps

Your enroliment is blocked

[ @ Enroliment code not recognized.

You've entered an invalid enrollment code too many times

Enter the enrollment code you received when you made certificate request . . -
For assistance, contact the administrator who provided your enrcliment code.
Enroliment code: If your administrator is unable to assist you, contact issuing center administrator,
123456789

© Entera vaid enrolmen cote Once the issue is resolved, click here to try again

Note: If you no longer have your enrollment code, contact AESO ETS Digital Certificate Administration

=4

cert admin@aeso.ca
1-868-588-2376
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Chrome or Edge Extension Error

Receipt of the below error messages may be received if there was an issue with installing an extension in your browser.

cligicert

Install DigiCert Authentication Client browser extension

You need to install DigiCert Authentication Client browser extension before you can enroll for your certificate.
DigiCert Authentication Client browser extension lets your browser communicate with DigiCert PKI Client to
manage your certificates.

Prerequisites:

+ You must have local administrator rights on your computer
+ Your browser security setting should not be set to High

Overview of DigiCert Autt ication Client browser

7|} Download and install the DigiCert Authentication Client browser extension from here

/. Ifyou have already installed DigiCert Authentication Client browser extension. ensure that it is enabled
digicert
21 Ifprompted, click Download to install PKI Client.
Follow the prompts to install PKI Client.
We've encountered an unexpected problem during extension
installation.

7)) Enrol for a certificate
After you install PKI Client, you will need to reboot your system. Once you have rebooted your system
find the enrollment mail and click on the link to begin the enrollment process again. There was an error installing or detecting the DigiCert PKI Client Chrome Extension. This may be because you
declined to allow it to be installed, or because of a problem during installation
More details on how to download the DigiCert Authentication Client browser extensions for Firefox and Chrome

can be found at the KB arlicle For assistance, contact AESO ETS Digital Certificate Administration.

Note: if you use Micresoft Internet Explorer 11, no extension is required cert admin@aeso ca
1-888-588-2376
®
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More information can be found by visiting the DigiCert website at: https:/knowledge.digicert.com/generalinformation/mpki-8-
pki-client---chrome-extension-installation.html .

Instructions for installing the extension in Edge and Chrome follow below.

Note: The AESO'’s supported browser is Microsoft Edge.

Installing the Extension in Edge

1. Open below link in the Edge browser: https://chrome.google.com/webstore/detail/digicert-authentication-
c/ikepfmbgiedamphopfpgomnipacokgol
2. Click on ‘Allow extensions from other Stores’ and a pop-up message will appear. Select ‘Allow’.

Note: Pop-ups may need to be enabled to allow the extension to be installed.

C M (3 https://chrome.google.com/webstore/detail/digicert-authenticatior

kepfmbgiedamphopfpgomnipacokgol?hi=en&lgl=US
Q You can now add extensions from the Chrome Web Store to Microsoft Edge. Allow extensions from other stores ’ i

Microsoft does not verify extensions installed from third-party stores. To get
s verified by Microsoft, go to the Microsoft Edge add-ons website.

exten:

Coneel

Home > Extensions > DigiCert Authentication ClientvEXtEnsIon

£ chrome web store

DigiCert Authentication Client Extension

% % % H 2 | Productivity | 100,000+ users
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3. Click on the ‘Add to Chrome’ button.

#~ chrome web store

Home » Extensions » DigiCert Authentication Client Extension

DigiCert Authentication Client Extension

A Kk k3 @ | Productivity | 100,000+ users

Overview Privacy practices Reviews Related

4. The following message will appear to add extension. Click on ‘Add extension’.

e Add "DigiCert Authentication Client Extension"?

It can:
Read and change all your data on all websites

Communicate with cooperating native applications

Add extension

5. Retry the certificate installation process.

Installing the Extension in Chrome

1. Open Google Chrome browser.
2. Go to extensions page by either clicking on the ‘Extensions’ icon on the top right (highlighted in below screenshoot), or
navigating to ‘3 dot elipses > settings > Extensions’.

= O X
& New Tab * -+

c o (al 2 +)[»]o0 @ :

= [m] X

@ Settings
= r N 0O . H & Youand Google

New tab Ctrl+T B Autofil
Mew window Ctrl+N @  Privacy and security
New Incognito window Ctrl+Shift=N

@  Appearance
History r Q,  Search engine
Downloads Ctrl+)

£ Defaul browser
Bookmarks 3

() Onstartup
Zoom - 100% =+ H
Print... Ctrl+P @ Languages
Cast... % Downloads
Find... Ctrl+F .

T Accessibility
More tools 4

N, System
Edit Cut Copy Paste

£)  Reset and clean up
Settings
Help 4 #  Extensions [
Exit ®  About Chrome
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3. Click on ‘Main menu’, and then ‘Open Chrome Web Store’.

“El@ Extensions @ Extensions

Extensions

Keyboard shortcuts

Open Chrome Web Store A

4. Search for ‘DigiCert Authentication Extension’ in the search box.

& chrome web store
Extensions ©
«Home

QO Extensions
DigiCert Authentication Client Extension

O  Themes
o Messaging API between web pages and DigiCert PKI Client
Ratings
o Y % % % K 3 Productivity
O *hkhk

O *&xxkh&up

10of 1 extensions

5. Click on the ‘blue key symbol’ to open the extension.

& chrome web store

Q_  DigiCert Authentica X Extensions ®

«Home

(O  Extensions
o ™ DigiCert Authentication Client Extension
emes
0 Messaging API between web pages and DigiCert PKI Client
Ratir
e ek e s K 3 Productivity

O *hkkkk

O *kkkkauw

1of 1 extensions

6. Click on ‘Add to Chrome’ button.

= chrome web store
Home > Extensions > DigiCert Authentication Client Extension

DigiCert Authentication Client Extension

W Wk k 3 @ | Productivity | 100,000+ users

Overview Privacy practices Reviews Related

Add to Chrome
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7. Click on ‘Add extension’.

e Add "DigiCert Authentication Client Extension?

It cam:
Read and change all your data on all websites

Communicate with cooperating native applications

Add extension

8. Retry the certificate installation process.

Certificate not trusted — installation of Root Security Certificate

The following error messages may be displayed if there is an issue installing the root security certificate. A root security
certificate is used to validate the individual digital certificates used to access ETS. The root security certificate is normally
installed at the same time as an individual certificate. However, sometimes this process fails, and the root security certificate
may need to be installed manually. The certificate can be found at https://www.aeso.ca/market/market-participation/system-
tools/energy-trading-system-tools/ - ETS Root Security Certificate. See installation instructions below.

Note: Access to ETS may still be possible without installation of the root security certificate.

digicert PKICLIENT
Where is your certificate?

digicert

Enroll:

. Your was

Import a certificate

Certificate enroliment is complete (g piicen pi cient

Your centificate is now available for use

Issued: Jan 6, 2021

® @ Your attention is needed e -
We could not configure your centificate 1o support PHI Client W

your online services. Policy
Contact your acministrator for heip
AESO ETS Production V1.1
Eror. 12 An error occurred during post-processing
Logal Notices. | Privacy
© 2022 DigiCent, lnc. AN rights reserved

To install the ETS Root Security Certificate, follow these instructions:

1. Select ‘ETS Root Security Certificate’.

ETS Root Security Certificate

2. Open the downloaded zip file.

5 aeso_electric_system_operator_ca Security Certificate
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3. Double click on the Security Certificate file. You will see the following dialog box. Click ‘Install Certificate’.

| Certificate = =

General petails Certification Path

L= §/ Certificate Information

This certificate is i for the fing pur,

« Allissuance policies
« all application policies

Issued to: Alberta Electric System Operator CA
Issued by: Alberta Electric System Operator CA

valid from 8/10/2016 to §/10/2025

Install Certificate... Issuer Statement

4. Select ‘Current User and ‘Next’.

X
£* Certificate Import Wizard

Welcome to the Certificate Import Wizard
This wizard helps you copy certificates, certificate trust lists, and certificate revocation
lists from your disk to a certificate store.
A certificate, which is issued by a certification authority, is a confirmation of your identity
and contains information used to protect data or to establish secure network
connections. A certificate store is the system area where certificates are kept.

@) Current User

(O Local Machine
To continue, dlick Next.

Next Cancel
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5. Select ‘Automatically select the certificate store based on the type of certificate’ and ‘Next'.

X

€ &* Certificate Import Wizard

Certificate Store
Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate.

I@ Automatically select the certificate store based on the type of certificate I
(O Place all certificates in the following store

Browse...

6. Select ‘Finish’

€ &* Certificate Import Wizard

Completing the Certificate Import Wizard

The certificate will be imported after you dick Finish.

You have specified the following settings:

Rl et Automatically determined by the wizard

Content Certificate

Once the certificate is installed you will need to close all browser windows as well as the PKI Client.
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7. Reopen the PKI Client application. The certificate should now be shown as ‘valid’.

About | Need help? | Advanced

digicert PKI CLIENT
Where is your certificate?

- | Plug in your |

smart card

My Computer

AESOETS Prod_.
(10 Certificates)

Import a certificate

Version (Expiration date - certificate name): Delete ceriificate
Export certificate
Note: Any action applies only to the selected version Rename certificate
Issued: Sep 19, 2021 View certificate details
Expires: Oct 20, 2022

PKI Client Trust:

Policy: urn-x-pkiclient- v
policy reference.ﬂ:aHRD:H)MGL

Firewall preventing you from accessing your certificate

Some companies have firewalls that prevent the PKI Client application from retrieving a certificate. If you have followed the
instructions and still cannot see your certificate, you may wish to contact your IT Department and verify PKI Client is not being
blocked.

B

This site can’t provide a secure connection

ets.aeso.ca didn't accept your login certificate, or one may not have been provided,

Unable to Login to ETS

After installing your certificate and you have attempted to login to ETS, successful login will be indicated by a banner at
the top of the screen welcoming you by name to ETS, “Welcome [your certificate name] of [company]”.

aeso / @) | welcome John Smith ABCE of ABC Electric Ltd. |
B 6m(i‘

[=

ETS Reports

Version: 11.9.0.84
Current AIES Event Log 7 | Supply Surplus o System Marginal Price d
Historical Click here for information about 'Energy Emergency Alerts’ RBPOFl Projected Pool Price for Hour Ending 16 is §75.32 as of
_ I Date/Time || Comments I 15:50.

If you do not see your certificate name and you still see a login button in the top right corner (shown below) or if you have
multiple certificates and you do not see your certificate in the list, this suggests your certificate is not properly installed.
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ETS LOGIN )}

Reports Version: 9.6.1.6

Below is a list of troubleshooting tips you can try:

e Restart your computer.

¢ Confirm DigiCert PKI Client application was installed properly by searching for the application on your start menu
and confirm it loads correctly.

¢ Confirm DigiCert PKI Client application installed is the latest version. This can be verified by opening DigiCert PKI
Client, clicking ‘About’ and ‘Check for updates’.

¢ In the DigiCert PKI Client application, confirm you see your certificate and confirm the certificate is not expired.

o Verify your certificate is listed in the ‘personal’ store of your browser (settings section) and the expiry date is in the
future.

e Check to see if the Root Security certificate has been installed (instructions on installation of this certificate are noted
in this document).

e Installation of your certificate may require additional operating system privileges. Check with your IT department.

¢ Make sure cookies are enabled as cookies are required for ETS to function properly.

e Check to see if your company firewall is blocking the ETS website. A timeout error may appear or the process never
completes and ETS does not load. AESO has two IP addresses. Ensure your company firewall is not blocking
these.

o If you selected the wrong certificate (e.g. the ETS training certificate), this will now become the default certificate
used for ETS. Log into ETS, if it does not ask for a certificate and you do not see the Welcome line at the top of the
screen start a new session in Edge by right clicking the Edge icon (in the start menu or in the task bar) and select
‘New InPrivate window’'. To reset the default certificate, log off your account or restart your computer, and then
log in to ETS selecting the correct certificate.

e Check SSL configuration - To do so, open ‘Internet Options’ in Windows Control Panel. Click the ‘Advanced’ tab.
Scroll down and ensure that TLS is enabled. For Windows TLS 1.3, ensure that TLS 1.2 is enabled and both TLS
1.0 and TLS 1.1 are disabled. Note — TLS 1.3 only works on Windows 11.

" &% Internet Properties ? e

General Security Privacy Content Connections Programs Advanced

Settings

] Allow software to run or install even if the signature is invi A
[ Block unsecured images with other mixed content

Check for publisher's certificate revocation

Check for server certificate revocation

Check for signatures on dewnloaded programs

[ Do not save encrypted pages to disk

[] Empty Temporary Internet Files folder when browser is dc
Enable DOM Storage

Enable Integrated Windows Authentication

Enable native XMLHTTP suppart

] Send Do Not Track requests to sites you visit in Internet £
[] use ssL 3.0

Use TLS 1.0

Use TLS 1.1

Use TLS 1.2

[[] Use TLS 1.3 (experimental)

Warn about certificate address mismatch

[] wamn if changing between secure and not secure mode
Warn if POST submittal is redirected to a zone that does n "

< >

Restore advanced settings

=
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o Disable the HTTPS deep inspection - Network cybersecurity tools will sometimes be installed that are decrypting and
re-encrypting network traffic to scan for malware. Sometimes this requires sites to be ‘whitelisted’, otherwise the
connection between the browser and the website will fail (the browser and the website will detect that a third party
has tampered with the connection). Asking for the deep inspection to be disabled will allow you to then test if
connectivity works. If it does, then your security team will need to do the whitelisting of ets.aeso.ca.

e Clear cache - Close all browsers and open ‘Intemet Options’ in Windows Control Panel. Click the ‘Content tab’. Click
the ‘Clear SSL state’ button. Open an Edge browser. Click the “...” beside your profile. Select ‘Settings’ from the drop
down menu.

6 ¢ v w @ [-

Enter “cache” in the search box. In ‘Clear browsing data now’ select ‘Choose what to clear’.

= Settings Q cache X

Clear browsing data - 1 result

This includes history, passwords, cookies, and more. Only data from this profile will be deleted. Manage your data

Clear browsing data now Choose what to clear
1 result
Choose what to clear every time you close the browser >

Change the drop down to ‘All time’. Uncheck ‘Browsing History’ and ‘Download History’. Ensure only ‘Cookies and
other site data’ and ‘Cached images and files’ are checked. If you use your Edge profile on multiple machines, you
can ‘sign out’ on this browser first and then click the ‘Clear now’ ‘button if you only wish to clear the cache on this
machine.

Clear browsing data

Time range

Last hour v

|:\ Browsing history

15 items. Includes autocompletions in the address ba

|:\ Download history
None

Cookies and other site data

From 17 sites. Signs you out of most sites.

Cached images and files

Frees up less than 319 MB. Some sites may load more

Clear browsing data for Internet Explorer mode

This will clear your data across all your synced devices signed in to
Fillitsa.Sfillington@aeso.ca. [P clear browsing data from this
device dfply, sign out first

Clear now Cancel
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o Certificate import cannot have strong private key protection enabled. When installing the certificate using Windows
Certificate Import Wizard to import the certificate (instead of via PKI Client), at the step when you enter the certificate
password you must uncheck ‘Enable strong private key protection’.

X

€ £* Certificate Import Wizard

Private key protection
To maintain security, the private key was protected with a password.

Type the password for the private key.

Password:
[l
[[]pisplay Password

s

[[]Enable strong private key protection. You will be prompted every time the
private key is used by an application if you enable this option.

[[IMark this key as exportable. This will allow you to back up or transport your
keys at a later time.

Protect private key using virtualized-based security(Non-exportable

Indude all extended properties.

Next Cancel

Installing certificates on a new computer

If you still have access to your old computer, you may follow the instructions below.

1. Export your digital certificate. For step-by-step instructions refer to our Exporting a Digital Certificate Guide at
https://www.aeso.ca/market/market-participation/system-tools/energy-trading-system-tools/.

2. Transfer the exported certificate to your new computer.

3. If you have not already done so, download and install DigiCert PKI Client application on your new computer. For
step-by-step instruction refer to our ETS Digital Certificate Enroliment Guide located at
https://www.aeso.ca/market/market-participation/system-tools/energy-trading-system-tools/.

4. Import your digital certificate. For step-by-step instructions refer to our Importing Digital Certificates Guide at
https://www.aeso.ca/market/market-participation/system-tools/energy-trading-system-tools/.

If you did not export your existing certificate(s) before losing access to your old computer, you may request reissue of
your certificate by sending an email to cert.admin@aeso.ca. Your existing certificate will be revoked, and a new certificate will
be issued.

Updated: 2022-10-27 Page 11 Public


https://www.aeso.ca/market/market-participation/system-tools/energy-trading-system-tools/
https://www.aeso.ca/market/market-participation/system-tools/energy-trading-system-tools/
https://www.aeso.ca/market/market-participation/system-tools/energy-trading-system-tools/
mailto:cert.admin@aeso.ca

